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Frequently Asked Questions

StarSCAN®

GENERAL INFORMATION

Who can | contact regarding StarSCAN help, questions, and concerns?

Before contacting someone regarding StarSCAN questions and concerns, review the following:

¢ Review this StarSCAN FAQ (Frequently Asked Questions) document
* Visit one of the following websites for information pertaining to your question

Web Site

Link

DCCTools Website

www.dcctools.com

StarSCAN Information

DealerCONNECT > Service > Repair > StarSCAN/StarMOBILE

DealerCONNECT eSupport Link

DealerCONNECT > Service > Repair > Star Online

STAR Center Online

DealerCONNECT > eSupport > Knowledge Center > Find Answers

If your problem cannot be resolved through the steps above, please call the Technical Service
Hotline associated with the problem you are experiencing. They will help you resolve the issue

or direct you to the appropriate resource.

Type of Problem

Location

Hotline

Number

Vehicle Diagnosis Issues

us

STAR Center

+1 800-850-7827

Canada (French)

STAR Center

+1800-361-1702

Canada (English)

STAR Center

+1 800-361-2702

Mexico

STAR Center

+52 55 5081 7279, +52 55 5081 7063

Europe (Brussels)

STAR Center

+32 27 75 4532

Repair

us DealerCONNECT +1 800-374-4040

Canada Auto Analyser +1 866-233-6733

Mexico DealerCONNECT +52 55 5081 7389, +52 55 5081 7390
j:;tmrtsv'or‘rﬁigalts'zzis“es Europe, Middle East, South

America (Brussels) DealerCONNECT +32 2 706 2551

Australia DealerCONNECT +61 03 9566 9276

All other countries DealerCONNECT +1 780 409-4588

us SPX +1 800-801-5420
StarSCAN Diagnostic Tool Canada Auto Analyser +1 866-233-6733

International

SPX

+44 0 1327 303467

Who can Fleet and Aftermarket customers contact regarding StarSCAN help, questions,

and concerns?

Before contacting someone regarding StarSCAN questions and concerns, review the following:

2/13/08

vi.7

Page 4 of 20




Frequently Asked Questions StarSGAII((

* Review this StarSCAN FAQ (Frequently Asked Questions) document
¢ Visit one of the following websites for information pertaining to your question

Web Site Link

DCCTools Website www.dcctools.com

StarSCAN Information DealerCONNECT > Service > Repair > StarSCAN/StarMOBILE
DealerCONNECT eSupport Link DealerCONNECT > Service > Repair > Star Online

STAR Center Online DealerCONNECT > eSupport > Knowledge Center > Find Answers

If your problem cannot be resolved through the steps above, please call the Technical Service
Hotline associated with the problem you are experiencing. They will help you resolve the issue
or direct you to the appropriate resource.

Hotline Type of Problem Number
Aftermarket Hotline | Software installation or networking issues 800.801.5420
Fleet Service Fleet Inquiries 248.512.7960
Hardware Repair Hardware repairs / issues 1-800-801-5420

How do dealerships or aftermarket customers order the StarSCAN tool?

All orders for DRBIII®, StarSCAN®, StarMOBILE®, and related accessories can be placed
through Miller Special Tools at 1-800-801-5420.

What is the process for ordering a StarSCAN carrying case?

The StarSCAN Carrying Case will cost $79.00 (U.S.) or $96.88 (Canadian) and is currently
available for shipping. To order a StarSCAN carrying case, complete the following steps:

1. Call Miller Special Tool at (800) 801-5420

2. Request StarSCAN Carrying Case (P/N CH9405)
My kit arrived incomplete: where’s the Read-Me First and other documentation?
The documentation is located in the soft nylon pouch that is attached to the lid of the StarSCAN
case.
Where should | send Canadian StarSCAN tools in for repair?
Canadian StarSCAN users (Part Number CH9400-CAN) should direct all calls or repairs to the
following:

Auto Analyser Services
7353 Castlederg Side Road
Caledon, Ontario CA L7COP7
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(866) 233-6733 (Toll Free)
(905) 951-7111 (Local)

How should Dealerships report their stolen DRBIII, StarSCAN or StarMOBILE Tool?

Dealerships whose DRBIII, StarSCAN or StarMOBILE tool has been stolen should call and
report the tools S/N (Serial Number) with SPX Miller Special Tools at (800) 344-4013. Once the
Serial Number is recorded with SPX Miller Special Tools, any future tool repair work will first
checked against this Stolen Tool list and, if identified as stolen, will be returned to its rightful
owner.

What is the latest information on the StarSCAN Upgrade program?

For StarSCAN tools manufactured before April of 2004, we are launching a free special
StarSCAN Upgrade Program. Included in this program are several hardware and software
enhancements that have been added to the tool since the initial launch. This upgrade program
will be provided by Miller Special Tool at NO CHARGE.

Dealers will be contacted only if their StarSCAN was manufactured before April of 2004, and
has not yet been in for service. All other dealers will be mailed a CH9414 kickstand/hook at NO
CHARGE. If you have any questions, contact SPX Miller Special Tools at (800) 344-4013.

How do | find out what the latest StarSCAN software version is?

To find the latest software version available for the StarSCAN tool, select Latest News at
www.dcctools.com.

Why does the StarSCAN take so long to boot up?

The StarSCAN is a stand-alone device that is much like a personal computer. When it is first
turned on, it must run a number of processes before it can be used. These include loading an
operating system, starting Java software, identifying the connected vehicle, etc.

You can avoid booting up your StarSCAN by leaving the tool plugged into the AC adapter and
powered up between uses. Because the tool is only charged while it is on, this will also keep
the battery fully charged. We do recommend, however, that the tool be restarted once a day to
free up internal memory and avoid system slow downs and errors from occurring.

Can the StarMOBILE A/C Adapter (CH9802) be used to power the StarSCAN
diagnostic tool?

Although the plugs are the same size, you should not use the StarMOBILE adapter with the
StarSCAN tool. Under some circumstances, the StarSCAN power requirements can exceed the

capacity of the StarMOBILE adapter. However, the StarSCAN A/C adapter may be used to
power the StarMOBILE system.

Can the StarMOBILE vehicle cable (CH9804) be used with the StarSCAN diagnostic
tool?

Although both tools use HD-26 connectors, you cannot use the StarMOBILE cable with the
StarSCAN tool. The StarMOBILE cable was designed to be as small as possible for use in the
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customer’s vehicle. Since the StarMOBILE power requirements are much less than the
StarSCAN tool, we were able to reduce the size of the StarMOBILE cable. However, the
StarSCAN cable (CH9404) may be used with the StarMOBILE system.

MISCELLANEOUS TROUBLESHOOTING

Why can'’t | print PDF files after installing the latest version of Adobe Acrobat?

DealerCONNECT recommends uninstalling the current version of Acrobat then downloading the
latest version from DealerCONNECT > eSupport > Library > Downloads and installing it. You
will still be able to view PDF files from the StarSCAN website with this version as well.

What does my StarSCAN lock up at the key cycle step of an SCI flash?
Why can’t | connect to a’06 DR SRT-107?
Why can’t | communicate with the PCM module on a 2006 KJ Liberty vehicle?

A potential cause of communication and flash difficulties is a StarSCAN vehicle cable which has
one or more broken or damaged wires internally. Three common symptoms of this type of
problem are described below:

1. An occasional “lockup” at the key cycle steps when performing an SCI flash for
PCM/TCM. This problem is normally seen during a flash of engine/transmission
controllers on ‘04 and ‘05 CAN bus vehicles.

2. Attempting to connect to a 2006 Dodge Ram SRT-10.

3. Inability to read the PCM on ‘06 Liberty Diesel.

If a StarSCAN exhibits any of these symptoms, the cable should be tested to ensure that there
are no broken wires. This continuity test can be done with a multi-meter set to measure
resistance or with a continuity tester. The wiring of the cable is straight through. In other words,
Pin 1 on the StarSCAN connector will be connected to Pin 1 of the vehicle connector (see
figures below). The following steps can be used to perform the continuity test:

1. Obtain a multi-meter and set it to measure resistance.

2. Connect one probe of the multi-meter to Pin 1 on the vehicle connector and connect the
other probe to Pin 1 on the StarSCAN connector. Care must be taken here to ensure
that the probes make good contact with each pin. There may be some difficulty in
obtaining contact between the probe and the metal contacts in the StarSCAN connector.
Note: A common trick to this problem is to insert a straitened paper clip into the desired
pin of the StarSCAN Connector. Doing this allows you to touch the multi-meter probe to
the exposed part of the straitened paper clip.

3. Read the measured resistance on the multi-meter. If the measured resistance is beyond
the range of the multi-meter, the wire is most likely broken. Common resistance values
for a StarSCAN cable are less than 1 ohm.
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4. Repeat for each of the 16 pins on the StarSCAN cable. If a broken or open wire is
discovered within the cable for any of the 16 pins on the vehicle connector, a new cable
should be ordered from SPX Miller Special Tools at 800-801-5420.

Why won't my StarSCAN tool power off when | press or press and hold the power key?

Complete the following steps if you are unable to power off your StarSCAN tool:

1. Remove the internal battery pack located on the lower right side of the StarSCAN tool
and disconnect all external power sources (A/C Power, Vehicle Cable, MDS2 DIN
Cable).

2. Re-install the internal battery pack and connect the StarSCAN tool to an external power
source (A/C power Cable, Vehicle Cable, or MDS2 DIN Cable).

Reconnecting an external power source may be necessary because the internal
rechargeable battery may be discharged.

3. Press the Power key.

Why won’t the tutorials on the dcctools website run on my computer?

Tutorials on www.dcctools.com page require the Macromedia Flash player be installed on your
machine to run properly. You may download the Flash player from the DealerCONNECT
website by going to ‘eSupport’ then clicking on the ‘Downloads’ link. Click on the ‘Flash Player’
link and follow the instructions for download and installation.

TOOL FEATURES

How do | enter characters not present on the StarSCAN Virtual Keyboard?

Pressing and holding either Shift button on the StarSCAN’s keypad (when the virtual keypad is
visible) will change the first row of keys on the virtual keyboard as shown below:
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Normal Keys 1

@I\)
H
RN
2
>
o (N
*
|

Keys when Shift pressed !

& Virtual Keyboard £ Virtual Keyboard

User Id |7990ab User Id (17990ab

Note: Pressing both Shift buttons on the StarSCAN'’s keypad at the same time will bring up a
hidden system menu. If this occurs, simply exit out of the system menu and you will be returned

to the normal StarSCAN application screen.
How do | calibrate and test the touchscreen on the StarSCAN Tool?
To calibrate the StarSCAN touchscreen, perform the following steps:

1. Power up the StarSCAN tool and allow the application to load up the home screen.
2. Once the home screen is loaded, press the both Shift keys on the StarSCAN key pad
simultaneously. This will bring up the system menu below:

3. Select Calibrate Touchscreen and follow the instructions.
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To test the StarSCAN touchscreen, perform the following steps:

1. Follow steps 1 and 2 above to view the StarSCAN System Menu.
2. Select Self Tests, then Test Touchscreen and follow the instructions.

How do | set the StarSCAN tool to Factory Defaults?

NOTE! This procedure will erase network configurations on the StarSCAN. Be sure to copy
current network settings/information before performing this procedure.

To reset the StarSCAN tool to factory default settings, complete the following steps:

1. Power up the StarSCAN tool and allow the application to load up the home screen.

2. Once the home screen is loaded, press the both Shift keys on the StarSCAN key pad
simultaneously. This will bring up the system menu below:

3. From the System Menu, select Advanced, then Restore to Factory Defaults. The
StarSCAN tool will revert to factory default settings.

What is the Vehicle Preparation feature?

Vehicle Preparation provides users with a list of common functions typically used during new
vehicle preparation. Examples include:

e Sound Horn On Lock

Flash Hazard Lamps On Lock
Headlamps Delay Time
llluminated Entry Time

Program Additional Ignition Keys

All items that are available under Vehicle Preparation can also be found by navigating to ECU
View > ECU Overview > Misc. Functions and ECU View > ECU Overview > More Options >
System Tests.

What is the red flashing SIM button that sometimes appears on the Title Bar?

The red “SIM” button appears whenever the tool is in a simulated mode of operation. This
mode is intended for purposes of demonstration and training only, and isn’t intended for live on-
vehicle diagnosis. Pressing the button will invoke a dialog box with settings that you can adjust
in order to exit simulated mode.

How does the StarSCAN tool’s vehicle connection system work?

There are certain conditions that must exist for the StarSCAN scan tool to communicate with a
vehicle. The first conditions that must be met for the StarSCAN tool to operate properly are that
power and grounds must be connected at the Data Link Connector (DLC). This means that pin
16 on the DLC will need to have battery voltage (B+) at all times and that pins 4 and 5 have a
“clean” path to ground. When the StarSCAN is turned on and plugged into the DLC, the light
near the power button on the StarSCAN tool will turn green when vehicle power is present. If
the StarSCAN tool is running off of its internal battery, then the light will be a solid red. A green
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light with an occasional red blink means that the StarSCAN tool is running off of the vehicle’s
battery and charging its internal battery. Note: on boot up, the StarSCAN tool may take a few
seconds to recognize that vehicle battery is present.

If you don’t see a green light, then check all of your cable connections from the StarSCAN tool
to the DLC. Also check that the vehicle’s battery voltage is at least 10.5 Volts. This is the
approximate voltage at which the StarSCAN tool will switch from vehicle power to internal
battery power for most of its hardware. Vehicle communications hardware on the StarSCAN
tool would still draw off of vehicle power and function above 6 Volts. If all of these conditions
are met and you are still having trouble communicating, then try a different vehicle.

If vehicle battery is present, the StarSCAN tool will attempt to identify the cable attached to it.
Currently, there are 2 types of cables that can be connected to the StarSCAN vehicle connector.
They are the standard vehicle communications cable and the MDS2 Power Supply Cable. The
MDS2 Power Supply Cable is used only to apply power to the StarSCAN tool and can’t be used
for communications. So, the StarSCAN tool will not attempt to communicate with a vehicle if
that cable is attached to it. In order to connect to a vehicle, you must use the standard vehicle
communications cable and hook it up to the DLC of the vehicle.

Once the cable identification has identified a valid communications cable, the StarSCAN tool will
attempt to identify the vehicle. If it is not successful identifying the vehicle, a screen will pop up
asking you to tell the StarSCAN tool what vehicle you are connected to. Only vehicles
supported by the StarSCAN software will be shown in the list. Note: It is required that the
vehicle’s ignition be placed in the ‘Run’ position prior to connecting to a vehicle. If this is not,
then the automated identification process on CAN vehicles may not work properly.

Sometimes, communication problems between the vehicle and diagnostic tools are due to
problems with the vehicle cable, the DLC connector, or some internal wiring fault. The
StarSCAN tool has the ability to detect some of the common faults that can occur on the
Diagnostic CAN-C bus, which runs from the DLC to the CGW (Central Gateway Module which is
usually the FCM). Note that most, but not all vehicles have a Diagnostic CAN-C bus. Faults
that can be detected by the StarSCAN tool include open circuits, shorts to ground and battery,
and bus wires shorted to each other. The Diagnostic CAN-C bus can be diagnosed by going
into “Network View” and then pressing the “Diag CAN-C” button. This will bring up a screen
containing fault information and controls to rerun the bus test used to determine these faults.
Note that all fault information on this screen needs to be manually verified by using the proper
diagnostic procedures.

The automated identification of vehicles will immediately load the year, model, engine, and VIN
from the vehicle. This information can be seen on the left side of the title bar.

How do | View StarSCAN recordings on the PC using StarMOBILE Desktop Client?

Follow the step-by-step instructions below:

1. Turn on the StarSCAN tool and allow the application to load up the home screen. Select
More Options, then View Recordings, then select a recording.
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Recording Name Date

Creste Recordings

my recordings 2006-04-07

Geordng1 o [e006-0a-07

recording2 2006-04-07

2. Insert your StarSCAN approved USB memory device into the StarSCAN, select Manage

Files, then Copy to USB. When the file has been successfully copied to the USB device,
remove it and plug it into a PC.

I StarScan Remete Deskiop

lanage Fil Recording £.05 SP e Manage Files - Recording  £.05_SP3
Back =
Name Date. Size
my recordings 2006-04-07 |156234 ny roca) . Copy recording to the USB storage device?
recordingl 2006-04-07 156234 recordin
recording2 2006-04-07 156234 recordin
recording3 2006-04-07 |156234 recordin

g -1 -

Options

3. Launch the StarMOBILE Desktop Client application. Make sure the Use Automatic
Device Discovery checkbox is check and press Nextto continue.

StanbiOBLE Discovery Wizard

This wizard heips you connect 1 3 SRAMOELE device on you network
Make sue your SRIMOEILE device s lumedon and connecied b e
Bame NetWoTH sEgmEnt 38 fis PO

1 y0u are having problens connecting 1o yous SRMOBLE drvice through
s wazssd uncheck the Ausimatic Device Discovery belw and erist e
1P agd=ss manually

] Use dustomatc Device Discovery

Fress Nest io coninos

RN TN .

4. Select Disconnected Mode and press Finish.
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SHAOBAY Discovery Wiadia™

Detault SM0BILE Device Not Found w*
YoUr Getaul SEMCEILE CBvie can 0L b DUNCIOF iS I0CKEG by ANOME! CBSKIOH ~
chent. You can search for other SAMIOBLE devices of start the SRMM0BILE Desidon ™
Clientappiication in Disconnecied Mo,

Coobors -

) Press et o search kr ofue 5

Preas Fisi o strt s applcaton i Discannecied Mode

R R

5. On the home screen, go to More Options and then View Recordings.

o)
O] ¢ ngs

-
R
B

6. Next, select Manage Files, then More Options, then Copy From USB. The recordings
from the USB device should now appear.

| S by Corar 1 10 o]
[ s s
O] o] nEsa

Name

A
recording 1

recording2

Local
®
®

recording3 ® -

7. Select a recording and hit Load File. Once the recording is downloaded, the red x
should change to a green checkmark.
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8. To view the recordings go back to the home screen. Select More Options and then View
Recordings. The file that was downloaded should now appear. Select View Recording
to view the recording.

NETWORKING

How do | configure my StarSCAN for networking?

Refer to the StarSCAN Networking Guide or the StarSCAN Quick Start Networking Guide
available in the Download Center at www.dcctools.com and in DealerCONNECT under Service
> Repair > StarSCAN/StarMOBILE > Download Center. These documents contain step-by-step
instructions on how to set up your StarSCAN tool for networking.

What is the process for troubleshooting StarSCAN networking issues?

Refer to the StarSCAN Network Troubleshooting Guide available at in Download Center at
www.dcctools.com and in DealerCONNECT under Service > Repair > StarSCAN/StarMOBILE >
Download Center.

Does my StarSCAN diagnostic tool need to plug into my network?

Connection to the network is required for: downloading of up-to-date vehicle flash files,
StarSCAN software updates, downloading of templates, vehicle reconfiguration, and uploading
of data files to the STAR Center. For more information on how to configure the StarSCAN
diagnostic tool please see the Quick Start Networking Guide.
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What kind of networking changes might be needed to support the StarSCAN diagnostic
tool?

Dealerships should be equipped with a local area network (LAN) connection to meet their
needs. For more information regarding dealership networking changes please refer to
dealership guidelines, located at DealerCONNECT > eFiles > New Dealer > Infrastructure
Requirements.

Is StarSCAN wireless networking supported?

Wireless networking is not officially supported by Chrysler. Interested users can, however,
receive help that will allow them to enable beta wireless networking software on their StarSCAN.
To receive this help, call the DealerCONNECT hotline which will forward your help request to a
Tier 2 help group.

How many LAN drops should | plan for?

You will need separate LAN drops for each of the following:

Every service bay where the StarSCAN diagnostic tool is used
Every service bay where the StarMOBILE system is used
TechCONNECT client

Additional drops for future needs

What ports are required for the StarSCAN tool to access the Internet?
For the StarSCAN tool to access the Internet both ports 80 (HTTP) & 443 (HTTPS) are required.

Do | need Internet access in my service bay to use the StarSCAN diagnostic tool?

Yes. The StarSCAN diagnostic tool must be able to fully access the Internet. It employs HTTP
and HTTPS protocols operating over ports 80 and 443 respectively. Use of content filters and
other restrictive network devices may prevent the StarSCAN tool from having necessary access.

DOWNLOADING FLASH FILES

Where are the flash files on the StarSCAN & StarMOBILE Update CD?

Flash files are not included on the 6.06 StarSCAN & StarMOBILE Update CD, nor will they be
included in future release CD’s. Flash files will only be available online via DealerCONNECT or
Tech Authority. Providing flash files on DealerCONNECT and Tech Authority ensures that only
the most current flash files are used to update vehicle ECUs.

With the May 2006 release of the StarSCAN and StarMOBILE 6.06 CD, the developers at
DaimlerChrysler reached a long-planned development goal of providing flash files solely online.
By reaching this goal, you will now be able to access flash files that maintain the highest levels
of quality, consistency and availability. Additionally, developers will now have the ability to
respond quickly to any changes or issues found in the field and offer sound solutions to all in a
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timely manner. This will provide higher quality customer service with faster problem resolution
for our dealers.

How do | download flash files to the StarSCAN from the internet?

The StarSCAN is network capable. To set up your StarSCAN for networking, follow the
StarSCAN Quick Start Networking Guide, available from the ‘download center’ at the
www.dcctools.com or DealerCONNECT websites. This guide will also give you instructions on
how to download a flash file once your StarSCAN is configured for your network.

SOFTWARE UPDATES

Where can | find help instructions for updating my StarSCAN tool?

Refer to the StarSCAN Tool Update Instructions available in the Download Center at
www.dcctools.com and in DealerCONNECT under Service > Repair > StarSCAN/StarMOBILE >
Download Center. This document contains step-by-step instructions on how to update your
StarSCAN tool.

What is the StarSCAN Recovery Card used for?

The StarSCAN Recovery Card shipped with your StarSCAN tool was previously used to recover
StarSCAN software in certain emergency situations. The Recovery Card has since been
disabled since release 7.03, as these situations are no longer possible. Inserting the StarSCAN
Recovery Card into your StarSCAN will no longer have any affect. If you need to recover /
reload your StarSCAN tool software, you can do so by re-installing your software using the
latest StarSCAN & StarMOBILE Update CD shipped to your dealership.

What should | do if my StarSCAN & StarMOBILE Update CD is missing or defective?
To request a replacement, call the DealerCONNECT help desk at 800-374-4040.

Can | skip versions when | update my StarSCAN?

You can update from any version to the latest software version available. However, it is critical
that dealers keep their StarSCAN tools updated to the latest version available to ensure they
have the latest vehicle support. Dealers can find out what the latest available software version
is by visiting www.dcctools.com and selecting Latest News. This information is also available
through DealerCONNECT.
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USB MEMORY DEVICE

How can | order the 128 MB USB storage drive and adaptor?

To order a USB device, call Miller Special Tool at (800) 801-5420 and order a StarSCAN

Software Update Device Kit (P/N CH9412). This kit includes both a 128MB USB device and a
USB adapter.

Why does my USB device no longer work with my StarSCAN after | reformat it?

It is not recommended that you reformat your USB Memory device. If you have reformatted the
device and the StarSCAN no longer recognizes the USB Memory Device, it may have been

formatted to an incorrect format. To remedy this situation, reformat the USB Memory device
using the 'FAT32' option.

Format LEXAR MEDIA (E:) 2x
Capacity:
122M8 v
File system
[Fats2 / v
Allocation unit size
Default allocation size v

Volume |abel
LEXAR MEDIA

Format gptions
] Quick Format

( )

Why won’t my TechCONNECT PC recognize my USB device?

Some TechCONNECT PCs are unable to run both StarSCAN USB devices and BlueTOOTH
USB devices at the same time. This problem is very rare and affects only a small number of
TechCONNECT PCs. This problem can be resolved by completing the following steps:

1. Unplugging the BlueTOOTH device from the USB port.
2. Re-boot the TechCONNECT client.

There also have been a few reported issues with AK variants of the Lexar USB memory device
shipped in some of the StarSCAN Update Kits. The problem only affects a small number of
TechCONNECT machines. If you are experiencing problems with the TechCONNECT not
recognizing your Lexar JumpDrive and you are in the U.S. or Canada, contact the
DealerCONNECT Hotline at (800) 374-4040. All others should visit DealerCONNECT at
https://dealerconnect.chrysler.com for Hotline numbers in your locale.

Why am | getting an error when trying to write to my USB memory device?

You may have your memory device locked. To unlock the device, simply move the micro switch
located on the side of your USB memory device to the unlocked position.
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What should | do with the Kingston driver CD | received with my USB memory device?

Some StarSCAN Update Kits were inadvertently shipped with the Kingston driver CD. This CD
is not required for use the TechCONNECT and can be discarded.

Why can'’t | write to my USB device from the StarSCAN &StarMOBILE Software Update
CD?

Depending on the USB Device type and previous use, it is possible that the volume name or
label is blank. Beginning with the StarSCAN StarMOBILE 6.04 CD Release, this information is
required to better help identify the device when using the update wizard. Please use the
following procedure to correctly name your USB Device:

1. Right click the Start menu select Explore > My Computer to bring up the screen below:

[Ev v compures PR lgixi
Fle Edt View Favortes Tooks Help

GBack » = - (2] | Qsearch |Fyroders (B | B T X | -
=] @60 |unks

= = -_-ﬁ ']
3% Floppy Local Disk (C:) 0S1111_1106 Cor

L
@) ©)

1 object(s) selected B [ = My Computer

2. Right click on the USB removable drive and select Properties from the drop down menu
to bring up the screen as shown below:

Jid |

o] _om |_=

3. Type USB Drive in the text box labeled Label and click OK.

4. If the update wizard screen is currently open, close it by clicking the Exit button (lower
right) or by clicking the X'located in the top right corner of the update wizard screen.

5. With the USB key already plugged into your computer, launch the update wizard from
the StarSCAN/StarMOBILE Software Update CD. You should now be able to copy
updates successfully to your USB device.
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PACKAGING & DURABILITY

How well does the StarSCAN diagnostic tool handle shop conditions?

Drop tests, fluid resistance, and other durability tests have been performed to ensure that the
StarSCAN diagnostic tool is ruggedized and ready for use under normal shop conditions. The
larger display screen makes the StarSCAN diagnostic tool slightly more susceptible to damage
than the DRBIII®, but the advantages of the larger screen far outweigh any potential durability
issues.

What will happen if | touch the screen with brake fluid or oil on my hands?

The StarSCAN tool has been designed to operate in a typical shop environment and the
touchscreen is damage resistant to most service shop chemicals, but treating it with care will
ensure its long life. Use a clean damp non-abrasive cloth towel and glass cleaner (such as
Mopar Window Cleaner) to clean the touchscreen surface when necessary. Apply the cleaning
solution to the towel rather than directly to the touchscreen.

Do | need a protective cover for the StarSCAN touchscreen?

The StarSCAN touchscreen was selected for its ability to operate successfully in the shop
environment. The optical properties of the touchscreen have been carefully matched to the
display, the polarizer, and the other optical enhancements present that allow full sunlight
readability. Simple cleaning will be sufficient for ensuring a long life.

Will the StarSCAN diagnostic tool have a hook?

Yes. A hook was provided to all StarSCAN owners free of charge to enable the technician to
place the StarSCAN diagnostic tool in any number of locations on the vehicle. If you have not
received a hook, please contact SPX Miller Special Tools at (800) 344-4013..

PURCHASING OFF-THE-SHELF ITEMS FOR USE WITH STARSCAN

Can | purchase some of the items in the StarSCAN kit elsewhere?

Yes. To reduce the cost of ownership of the StarSCAN, we used as many off-the-shelf
components whenever possible. These components may be purchased directly by the
dealership to help reduce your costs. It is very important to use only the specific items listed
below to ensure proper operation of your StarSCAN. The items identified below have been
tested to ensure compatibility and safe operation with your StarSCAN.

Can | purchase the items found in the Update Kit directly?

Although the Update Kit (CH9412) is available for purchase from PSE by selecting eStore >
eStore Sites > Pentastar Service Equipment, the items contained in the kit may be purchased
directly from other sources. The only replacement items that we can recommend at this time
are:
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e USB Adapter A/F - Mini B/M Adapter. Part number: GCUSBAFXM available at
http://www.twstore.com/twstore/gcusbafxm.htmi

Will the StarSCAN accept standard peripherals such as mouse pointing devices and
keyboards?

Yes. Recommended standard peripherals that have been tested and are known to work on the
StarSCAN include:

Keyboards:
e Ortek Technology, MCK-600USB
¢ |BM Keyboard, Model # SK-8806, P/N 19K1760

Mouse Pointing Devices:

Microsoft Wheel Mouse Optical USB, X08 - 71118
Belkin FBE201-USB

Dell Optical by Logitech, 04P648

Kensington Value Mouse USB 3 Button, Model# 19430

Can | purchase the Ethernet cable directly?

Yes, the Ethernet cable provided with the StarSCAN kit is a standard Cat 5e cable with RJ45
termination.
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